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Runtime measurement

= Recall debug topic from lecture — timer for meas.

Measurement of runtime using timer

= Options:

o Starting the timer at the beginning of the code part to be measured and stopping the
timer when the code part is finished

o Starting the timer (even independently of the code part to be measured) and reading
its value at the beginning of the code part to be measured then reading the timer
value again when the code part to be measured reaches its end. The runtime is the
time difference between the two timer values.

" Error: time needed to read timer value increases the runtime
= Core timer: special timer, measures the processor runtime in CLK ticks

* Example for using the core timer:
o ARM cortex M3 (reading and calculating the difference requires 10 CLK cycles!!!)

printStart = DWT->CYCCNT; (9= printStart uint32_t Oxd7cda8
printTime = DWT->CYCCNT - printStart; || ®: printTime uint32_t 10 (Decimal)
$define CYCLE_COUNTI_START( cntr ) \
asm("r0 = emuclk; 30 = r0;": \
=k {cntr) d {entr)
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Runtime measurement

uC has a special built in timer/counter inside Data
Watch point and Trace (DWT) unit of Debug
interface

DWT is a 32-bit one, i.e., using default 14MHz CLK
signal the maximum amount of time that can be
measured is T_max=2"32/14MHz=5min

Runtime measurement is actually measurement
of CLK cycles that can be easily transformed into
time via CLK frequency

Counter used to measure runtime: Cycle Count
Register
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Runtime measurement

= Counter used to measure runtime: Cycle Count
Register (CYCCNT)

O When processor starts CYCCNT is zero

O Register can be accessed in the following way:
e DWT -> CYCCNT

O A possible solution to measure runtime:
runTime = DWT -> CYCCNT;
here comes the code whose runtime is to be measured
runTime = DWT -> CYCCNT — runtime — COMP_CONST;

O COMP_CONST is used to get zero runtime when no
code is applied -> reading of registers, calculations are
not part of the code to be measured itself
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

==+ New Silicon Labs Project O X
Project setup ﬁ
Select the board, part, and SDK for the project.
Boards:
Search ‘ A4

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev AD3) *

Part:

| Search ‘ ™

| EFM32GG990F1024 |

SDK:
|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel V| (7]

Manage SDKs...

@ < Back Finish Cancel
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Strating with a new project

" File->New->Project->Silicon Labs MCU Project:

== New Silicon Labs Project O X
Project setup @
Select the board, part, and SDK for the project.
Boards:
Search | w

EFM32 Giant Gecko Starter Kit board (BRD2200A Rev A03) *

Part:

| Search | W

| EFM32GG990F1024 |

SDK:

|Gecko SDK Suite: MCU 5.8.3.0, Micrium OS Kernel 5.7.0 (v2.6.3) (I\Simplicity_studio\devel

Manage SDKs...

@ < Back Finish Cancel

© BME-MIT

«= New Silicon Labs Project O X
Project setup E
Select the type of project.
Project Type:

@ Empty C Program - Create an empty C executable project.

(O Empty C++ Program - Create an empty C++ executable project.
(O Example - Create a working example for the part.

(O Library - Create an empty static library project.

(O Simplicity Configurator Program - Create a project whose contents are driven from
Simplicity Configurator.

@ < Back Finish Cancel
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Strating with a new project

= Give project name and location, and set

Copy content:

= MNew Silicon Labs Project

Project Configuration

Select the project name and location.

Project name: |runtime

[+] Use default location

With project files:
() Link to sources
O Link sdk and copy project sources

(@ Copy contents

@ < Back

r- learck e oo =, (= a, . 5 . c - ART
ChUsershkrebesz\SimplicityStudioiwa workspacey UART_COM

MNext =

Cancel

© BME-MIT
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Runtime measurement

" The value of COMP_CONST has to be measured
O Code: (CHIP_Init() has been removed)

int main (veoid)

{

uint32 t runTime;
uint32 t COMP CONST;

runTime = DWT->CYCCNT;
COMP CONST = DWT->CYCCNT - runTime; //calculation of COMP CONST

runTime = DWT->CYCCNT;
runTime = DWT->CYCCNT - runTime - COMP CONST; //checking of CCMP CONST
| 1 Launcher {} Simplicity IDE |45 Debug - Energy Profile
)= Variables 2 | % Breakpoints | ilii Registers | %< Expressions £ B \@| s ==
MName Type Value Location
&= runTime uint32 t 0 Ox2001fff4
t9= COMP_CONST uint32_t 7 w2001 0

O Value of COMP_CONST is 7
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Runtime measurement

= Determination of runtime of 3 type of operations
for 3 data types

= Use optimization level —00 ( = no optimization)
= Code that can be used: |32« a=300, =20, c=0;

runTime = DWT->CYCCNT;
Cc=ath;

runTime = DWT->CYCCNT - runTime - COMP CONST;

Summation: + 6 91 134
Multiplication: * 7 64 120
Division: / 11 91 164

Remark: runtime may depend on where the variables are declared:
before the main function (longer runT) or inside the main function

Variables are stored in different parts of the memory, and addressing
method may be different (relative or direct)

T T O T . Méré hnika é
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Runtime measurement

= Checking the disassembled code can also indicate
the runtime

O Note: not every instruction can be executed in one CLK
cycle -> this method is just a rough guess

= Disassembly & | Enter location here VH 2] Sl 3 T =
0000020e: movs r3, #0x0 ~
00000210: str r3, [r7,4#0=x4]
23 runTime = DWT->CYCCNT;
ooooozlz: 1dr r3, [pc,#0xlc] ; 0x22c
00000214: 1dr r3, [c3,#0x4]
Q0000216G: str r3, [r7,#0x14]
24 c=athb;
00000218 1dr r2, [r7,#0=c]
0000021a: 1dr r3, [c7,#0x8]
0o000021c: add r3,r2
0000021e: str r3, [r7,#0x4]
= J_Luu_J_mHde - runTime - COMP CONST;
00000220: 1dr r3, [pc,#0xc] ; 0x22c
00000222: 1dr r2, [r3, #0x4] v
ANANNTDA - T A P | M+~ L4i=-1A47
< >

| SR 2B~y =0
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Runtime measurement

= Division is always a time consuming operation for
an embedded system compared to summation

= HW support of division sometimes applied in a uC
that significantly reduces the runtime

= Disassembly &2 | Enter location here V|| & S| 4 B
00000212: 1dr r3, [pc,#0x20] ; 0x230 A

00000214: 1dr r3, [r3,#0x4]

1= 3~ 3~ [ -7 # iild
24 c=a/b;
00o000218: ldr r2, [r7,#0xc]

0000021a: 14r r3 Ir7 #0w81
0000021c: sdiwv r3i,r2,r3
00000220: SLT Tor (L1, F0XA] J
26 runTime = DWT->CYCCNT - runTime - COMP CONST;
00000222: 1dr r3, [pc, #0x10] ; 0x230
ogooooz24: 1dr r2, [r3,#0x4]
00000226: 1dr r3, [r7,#0x14]
0oo00228: subs r2,r2,r3
0000022a: 1dr r3, [7,#0x10] v
ﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂﬂ D T D
< >
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Runtime measurement

= Operations performed on floating point numbers
takes more runtime
O A function call is needed for floating point operations

0 Operation on mantissa and exponents takes more time
for summation than HW-supported multiplication

=2 Disassembly 2 | Enter location here || &1 fiy S & | £9 T
0o000216: 1dr r3, [r3,#0x4]
00000218 str r3, [r7,#0x14]
(24 c=a+b; N
0000021a: 1dr rl, [r7,#0x8]
0000021c: 1dr rd, [r7, #0xc]
0000021e: bl 0x00000250
0oooo222: 1 L0 L I e ¥
GDDEIEIEEQ: str r3, [r7,#0x4]
20 T T T TN — runTime - CUMP_CGNST;
00000226: 1dr r3, [pc,#0x10] ; 0x234
00000228: 1ldr r2, [r3,#0x4]
0000022a: 1dr r3, [r7,#0x14]
0o00022c: subs r2, r2, r3
0000022e: 1dr r3, [r7,#0x10]
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Runtime measurement

= Determination of runtime of type conversions
= Use optimization level —O0 ( = no optimization)
= Recall: no explicit operation is done “just” type
conversion
= Code that can be used:
a_float = (float) a_int; OR a_float = a_int;

int32. t = e 50 70
float 2 T 26
double 36 36 = e

- Méréstechnika és .
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Change of optimization level

" To generate a more efficient (in terms of memory
usage, runtime, etc.) code optimization should be

1

applied:
(03)

Project Run Window Help

Convert

MNew

Import

Open Project

Close Project

Build Configurations
Build Project

Build Working Set
Clean...

C/C++ Index

Properties 2

«== Properties for UART_COM_Development O x
type filter text Settings = v w
Resource
Builders -
. C/C++ Build Configuration: | GNU ARM v7.2.1 - Debug [ Active ] ~ | | Manage Configurations...
Board / Part / SDK

Build Variables

® Tool Settings i
Environment ® gs . Build Steps

Logging %+ Debug Settings
4 Project Modules & Memory Layout
Settings ~ B GNU ARM C Compiler
C/C++ General # Dialect
Refactoring History & Preprocessor
Run/Debug Settings 2 Symbols
# Includes

5 | Optimization
2 Debugging
2 Warnings

# Miscellaneous

T2

Build Artifact Binary Parsers @ Error Parsers

Optimization Level None (-00) | 6

Mone (-00)
Optimize for debugging (-
[ ] Omit frame pointer (-f Optimize (-01)

Other optimization flags

[ ] Pack structures (-fpack{Optimize mare (-02)
[ ] Short enums (-fshart-e Optimize most (-03)

)

.. .|Optimize for size (-Os
Place each function intc R o : o ( a

Place each data item into its own section (-fdz

© BME-MIT
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Runtime measurement

= When optimization applied no result can be found
since the optimizer “optimized out” the result and
all those variables that are not used later

= Variables iZ | ® Breakpoints |l Registers | €< Expressions 5@y T

MName Type Value Location

(9= ¢ Error: Not implemented (DW_OP 8)

O see warnings in the code

= To avid this use volatile to force the optimizer not
to “optimize out” these variables (even runtime)

= However optimizer may use different order or
removes operations that makes extremely difficult

to follow and runtime measurement is not easy to
be correctly done

A, A . aré nika é .
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Runtime measurement

= Determination of runtime of 3 type of operations
for 3 data types

= Use optimization level —03
= Code that can be used:

int32 t a=300, b=20, c=0;

runTime = DWT->CYCCNT;

c=a+thb;

runTime = DWT->CYCCNT - runTime - CCMP CONST;

Summation: + 6 86 129
Multiplication: * 6 59 115
Division: / 10 86 159

. Méréstechnika és .
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Runtime measurement

= Determination of runtime of type conversions
= Use optimization level =03 ( = no optimization)
= Code that can be used:

a_float = (float) a_int;

Int32. t = e 48 67
float 29 23
double 33 33

- Méréstechnika és .
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Runtime

Sum operation using

measurement

arrays: s = Yo A[i] * BJ[i]

Use optimization level =03

Arrays should be volatile int32 t

Code to be used to m

easure its runtime for

different N values:

#define N 15

volatile int32 t sum;
volatile 1int32 t A[N];
volatile int32 t B[N];

int ii;

runTime = DWT->CYCCNT:

sum = 0;

for (11i=0; 1i<N; ii++){
sum += A[ii]*B[1ii];

}

runTime = DWT->CYCCNT - runTime - COMP CONST;

© BME-MIT

Méréstechnika és
Informaciés Rendszerek
Tanszék

18.slide



Runtime measurement

= What are the runtimes for array sizes H=15...1007?

CLK cycles 121 129 137 257 271 285 657 1207
(-03)
CLK cycles 477 528 560 592 624 656 1513 2616
(-00)

= Compare the CLK cycles for N=<15,16,17> and
N=<18,19,20,50,100>

O There is a jump in the runtime

O Explanation: loop unroll operation due to optimization
level —O3

A, A, b - éréstechnika és .
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Runtime measurement

" Loop unroll operation: (only when N is constant)

O The optimizer extracts the FOR loop and perform
multiply and accumulate operation N times when
N<18

0 When N>=18 the optimizer performs the FOR loop
O Check disassembled code:

N<18 N>=18
49 sum += A[1i]*B[1ii]; 49 sum += A[ii]*B[ii];
000001fa: ldr r2, [sp, #0x10] 000001fc: add r3,sp,#0xal
000001fc: ldr r0, [sp,#0x4c] 00000l1fe: add.w r2,r3,rl,1s1 22
000001fe: ldr rl, [sp,#0xc] aooooz2o2: ldr r3, [r2, #-0x50]
00000200: mla rz2,r0,r2,rl 00000206: ldr rl, [r2, #-0x48]
00000204 : str r2, [sp,#0xc] 0o00020as 1dr r2, [sp, #0xc]
oooo020e: ldr rZ, [sp,#0x14] 43 for (ii=0; ii<N; ii++){
00000208: 1dr r0, [sp, #0x30] 0000020c: adds rl,#0x1l
0o00020a: 1ldr rl, [sp,#0xc] 45 sum += A[iil*B[ii];
0000020c: mla rz,rl,r2, rl 0000020e: mla r3,rl,r3,r2
00000210: str rz, [sp,#0xc] 47 for (1i=0; ii<N; ii++){
ooooo212: ldr rz, [sp, #0x16] 00000212: cmp rl, #0x12
00000214 : ldr rl, [sp,#0x54] 49 sum += A[ii]*B[ii];
00000216: ldr rl, [sp,#0xc] 00000214: str r3, [sp, #0xc]

- Méré hnika é .
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Time measurement, timers

= HW-based timers in Giant Gecko

HFPERCLKTME"

TiMn_CC0 D

PRSinputs —

TIMn_CC1 g_

PRSinputs —

Timn_cc2 X

PRSinputs —

Input logic

Input logic

Input logi

N\ /\[/\[/

Prescaler CNTCLK
Counter Note: For simplicity, all
> TIMERn_CCx registers are
control L] eg
> Update grouped together in the figure,
\ * condition but they all have individual Input
n Capture Registers
TIMERN_CNT TIMERn_TOP
Y
Quadrature |
- = - Overflow
Decod |
coder
=0 » Underflow
Input Capture
> Eige pre—" = Compare Match x
detect >
Y
= Compare and
H TIMERn_CCx = [ ‘oasd confic »] TiMn_coo
- |
> (ijtge; iz i I Co ‘ d
mpare an
> DAM config D4 TiMn_cc1
Compare and
[ e > BAM config »X] TiMn_cc2
 EEEE—
detect

© BME-MIT
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Time measurement, timers

= HW-based timers in Giant Gecko: simplified block

diagram
prescaler HM» l
P>
CLK reset TIMERO->CNT
(cmuClock HFPER) >
TIMERO->TOP }——] == |«
\ 4
IT +1
TIMERO->CNT
S l
void TIMERO_IRQHandler (void)
TIMERO->TOP
/M > -
IT IT Time

. Méréstechnika és .
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Time measurement, timers

* To handle the timer the LT
following files needed to be = E{hw-h“-f
. - & bsp_stk_leds.c
added to the project: [ bsp_stkc
&
O em_timer.c em_cmu.c & V3D
4 [~ emlib
O Include the corresponding - [ em_cmu.c
.F .
.h files into the code ’ E‘;L =m-gpie.c
2 E| Em_system.c
* To handle the LEDs the - ] em _timer.c
following files needed to be
added to the project: el

#include "em_cmu.h™

O bsp_bcc.c bsp_stk_leds.c #include "em timer.h"
. include “"bsp.h"
bsp_stk.cem_gpio.c . -

O Include bsp.h file into the code

- P h , SimplicityStudio\developer\sdks\gecko_sdk_suite\v1.1\platform\emlib\src\
at « SimplicityStudio\developer\sdks\gecko_sdk_suite\v1.1\hardware\kit\common\bsp\

L . Méréstechnika és .
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Time measurement, timers

= The timer shall be configured using the library functions
as follows:
O Setting the prescaler of the peripheral clock
O Enabling the clock of the timer
O Generation of the parameter structure for initialization

e Prescaler is set to the appropriate value

O Reset the timer

O Setting the value of TOP
O Clear the interrupt

O Enable the interrupt

e Enable the peripheral interrupt
* Enable the core-based interrupt for the Timer (NVIC)

- Méré hnika é .
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Time measurement, timers

Possible implementation:

// Setting the prescaler of the peripheral clock
CMU_ClockDivSet(cmuClock_HFPER, cmuClkDiv_1);

// 3k sk ok ok ok sk ok ok sk okosk ok ok skook ok okoskook kR skosk ok ok ok ok sk ok ckok

/] * TIMER inicialization *
// 2k ok ok e ok o ok ok sk s sk ok ok sk e Sk ok sk sde ok ke ok sk ke o ok ok sk ke

// Enable the clock of the timer
CMU_ClockEnable(cmuClock_TIMER®O, true);

// Generation of the parameter structure for initializatio
TIMER_Init_TypeDef TIMERO _init = TIMER_INIT_DEFAULT;

// Setting the prescaler

TIMERO_init.prescale = timerPrescalel; // timerPrescalel...timerPrescalel024
// Initialization using the parameter sturcture

//void TIMER_Init(TIMER_TypeDef *timer, const TIMER Init TypeDef *init);
TIMER _Init(TIMERO, &TIMERO_init);

// Reset the counter
TIMER_CounterSet(TIMERO, 0); //

- Méréstechnika és
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Time measurement, timers

// Setting the TOP value
//__STATIC INLINE void TIMER_TopSet(TIMER_TypeDef *timer, uint32_t val)
TIMER_TopSet(TIMER@, WRITE_HERE_THE _TOP_VALUE); // 14MHz/presc/TOP

// Clear the interrupt

//__STATIC _INLINE void TIMER_IntClear(TIMER_TypeDef *timer, uint32 t flags);

TIMER_IntClear(TIMER®, TIMER_IF_OF);

// Enable interrupt at peripheral
//TIMER_IntEnable(TIMER TypeDef *timer, uint32_t flags);
TIMER_IntEnable(TIMER®, TIMER_IF_OF);

// Enable interrupt at NVIC
NVIC EnableIRQ(TIMERO® _IRQn);

// 3k sk ke ok ok sk ookosk sk ok sk sk sk ok skosk ok skook skl sk sk ok ok ok ok ok skok

/] * LED initialization *
// (kkkkkkkkkkkkkkkkkkkkkkkkkkkkkk

BSP_LedsInit();

- Méréstechnika és
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Time measurement, timers

" Implementation of IT function to toggle LEDs:

//IT function that implements LED toggling - comes before main{}

void TIMERO_IRQHandler(void){

BSP_LedToggle(9);
TIMER IntClear(TIMER®, TIMER_IF_OF); //TIMER flag clear

}
=" Timer_Init_Default:

//Default values for timer 1init

#define TIMER_INIT_DEFAULT

{
1, /* Enable timer when init complete. */
9, /* Stop counter during debug halt. */
timerPrescalel, /* No prescaling. */
timerClkSelHFPerClk, /* Select HFPER clock. */
Q, /* Not 2x count mode. */
9, /* No ATI. */
timerInputActionNone, /* No action on falling input edge. */
timerInputActionNone, /* No action on rising input edge. */
timerModeUp, [* Up-counting. */
9, /* Do not clear DMA requests when DMA channel is active. */
9, /* Select X2 guadrature decode mode (if used). */
0, /* Disable one shot. */
(% /* Not started/stopped/reloaded by other timers. */

}

- Méré hnika é .
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Time measurement, timers

= Calculation of TOP value:

O Toggle the LEDs in every T=1s

O CLK frequency = 14MHz (default value for this uC)

O Tick time =T _tick = 1/14MHz

O Timer value where the timer should be reset = TOP value = N
e N=T/T tick=1s/(1/14MHz) = 14*1076 -> very large number
e Can we store such a large number in the Timer? What is the data width?
e When a timer data width is not enough the prescaler must be used

= Example:

O Timer is 16-bit wide -> 2216 = 65535 is the largest number to
store

O Prescaler must be applied, e.g., Prescale value256

e 14 000000/ 256 =54687.5
-> N=54688 will correspond to 1s (not precise: error ~9ppm)

- Méré hnika é .
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Working code

1 #include "em device.h"

2 #include "em chip.h"

2 #include "em timer.h"

4 #include "em cmu.h"

5 #include "em gpio.h"

¢ #include "bsp.h"

8 //IT function that implements LED toggling — comes before main{}
S=woid TIMERO IRQHandler (veoid) {

10 BSP_LedToggle (0);

11 TIMER IntClear (TIMERO, TIMER IF OF); //TIMER flag clear
121

13

14

S=int main (veoid) {

16 /* Chip errata */

7 CHIP Init();

19 // Setting the prescaler of the peripheral clock

20 CMU_ClockDivSet (cmuClock HFPER, cmuClkDiv_l];

21

29 S .

23 f/o* TIMER inicialization *

24 [ KA REAA AR KA AR I I AR KA E AR FEEE KKK

25

26 // Enable the clock of the timer

27 CMU_ClockEnable (cmuClock TIMERO, true):

28

29 // Generation of the parameter structure for initializatio
30 TIMER Init TypeDef TIMER0 init = TIMER INIT DEFAULT;

31 // Setting the prescaler

3z TIMERO init.prescale = timerPrescale256; // timerPrescalel...timerPrescalel024

- Méré hnika é .
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Working code

33 // Initialization using the parameter sturcture

34 //void TIMER Init(TIMER TypeDef *timer, const TIMER Init TypeDef *init):
35 'I'IMER_Init (TIMERO, &TIME‘.RU_init] ;

36

37 // Reset the counter

38 TIMER CountersSet (TIMERO, 0); //

3G

40 // Setting the TOP walue

41 // STATIC INLINE void TIMER TopSet (TIMER TypeDef *timer, uint32 t wval)
42 TIMER TopSet (TIMERO, 54688); // 14MHz/presc/TOP

43

44 // Clear the interrupt

5 // STATIC INLINE void TIMER IntClear (TIMER TypeDef *timer, uint32 t flags):;
46 TIMER IntClear (TIMERO, TIMER IF OF);

47

48 // Enable interrupt at peripheral

4G //TIMER IntEnable(TIMER TypeDef *timer, uint32 t flags);

TIMER IntEnable(TIMERO, TIMER IF OF);

// Enable interrupt at NVIC
WIC_EnableIRQ ( TII@'RG'_IRQH] ;

."' ."' T T R R R T T T T I T T S S

flo* LED initialization *

."' ."' e R R e R R R R R e e e R R R R e R R e 1

et I L O 5 Y S P T e B S e

oo

Lon N T T T T T T 0 o i I O L O 0 o i Ry

g BSP_LedsInit();

1

2 /* Infinite loop */
3 while (1) {

4 }
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